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Organising Supplier Accounts
At the heart of the Purchase Ledger lie the supplier
accounts.

These are the documents which record the trading
details — address, credit terms, purchase history — for
each supplier.  Invoices, credit notes, payments or
refunds are then entered against each account which
automatically increase or decrease the balance to pro-
vide a constantly updated record of what you have paid
and what you owe to whom.

This chapter looks at how you create supplier accounts.
It also looks at how you create your own supplier
categories in which to organise and group the individual
accounts in a logical and meaningful fashion.  These
categories enable you to locate suppliers more easily
from the database.

You can create up to 30 supplier categories — and each
category can hold up to 100 separate supplier accounts
— so you can arrange the supplier database to suit your
own particular needs.

For example, you may want to organise your supplier
accounts alphabetically or by geographical region.  A
third option is to group the supplier accounts according
to the type of services or products they provide.

You can assign short reference names to the individual
supplier accounts which are used to sort reports or
screen views in alphabetic order.

Before you start adding the supplier accounts, you may
want to devise a simple indexing system which will
help you group and retrieve information quickly and
easily.

A point of order...

Supplier category and account reference
names are sorted into numerical then alpha-

betical order both on the screen and on the relevant
supplier reports.  Therefore, if you want to organise
information other than alphabetically, you can prefix
each name with a number — as illustrated by the
example on the next page…
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Creating a Supplier Category
Having decided how to organise your suppliers, you are ready to enter the categories in which the supplier
accounts are stored.  Create a supplier category like this…

Double click the Purchase Ledger icon to open it…

In the bottom left corner of the Purchase
Ledger window, click the New Category
button to display this dialogue...

Type a suitable name then click OK to add the new
supplier category to the Purchase Ledger window…

Notice that once you have created a supplier category, an icon representing
it appears in the Purchase Ledger window.  Bear in mind that you do not
need to enter all the supplier categories in one go.
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Re-naming a supplier category

If you want to change the name of an
existing supplier category —

for example, to
change the order
in which it
appears on reports
(and on the screen) then click
the relevant category icon and
choose Change Item from the
Edit menu.  You can re-name
the supplier category from this
dialogue box…

Supplier categories (continued)

Deleting a supplier category

You are also able to delete a supplier
category provided that any supplier

accounts it contains have been transferred to other
categories or deleted — turn to the end of this
chapter to find out how this is done.  Once empty,
select the unwanted category then choose Delete
Item from the Edit menu to remove it.

Viewing supplier categories

Existing supplier categories can be
viewed as icons as shown on the next

page… …or they can be viewed as a list by
choosing the By Name option from the View menu.



Chapter 11 - 6

Building the Supplier Database

Creating a Supplier Account
Having created one or more supplier categories, you can now start entering the actual supplier accounts…

Double click the supplier
category to which the new
account is to be added…

… then click the New Supplier
button in the bottom left comer of
the category window.

The top part of the window is where you
record the supplier’s business details, enter
them as described over the page…
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Name:   Enter the supplier’s
full business name.

Address:   Type the supplier’s
business address in the four lines
provided.

Contact:  If applicable, enter the
name of the person to contact.

This is where you enter the
supplier’s telephone number .

Supplier Business Details

Use this box to enter the
supplier’s fax number .
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VAT Information Required…

When completing your VAT returns, you are required to provide separate VAT information regarding supplies
purchased from other member states of the European Community (EC).

Bottom Line extracts VAT information for EC acquisitions according to the country identifier that you use to
prefix the supplier’s VAT registration number.

You will notice that the country identifier is preset to GB — use this prefix when setting up an account for a sup-
plier based in the UK.  For a country outside the EC, select the blank option from the pop-up menu.

If the supplier is based in another EC member state, use the pop-up menu to select the correct country identifier —
for example, FR for France; ES for Spain.
Transactions posted to suppliers with prefixes
other than GB or blank will be treated as EC
acquisitions and recorded in the appropriate
manner on your VAT Return report.

Having set the country identifier, enter the
supplier’s VAT registration number.

For a non-UK supplier, click here to select the country identifier
from the pop-up menu.  You can type the identifier if you prefer.

Having specified the country identifier, enter
the supplier’s VAT registration number.
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Supplier Terms

Whatever goods or services you
receive from this supplier then,
sooner or later, you will be
expected to settle the bill.  The
supplier may insist on payment
at the time of purchase or,
preferably, allow you to repay
the amount owing within an
agreed period of time.

Use the Payment Terms option
to specify the number of days
credit — starting from zero for
immediate payment.

Whenever you post an invoice to
this account, Bottom Line looks
at the invoice date you have
entered then uses the specified
number of days credit to
calculate when payment is due.
Any invoices remaining unpaid
beyond the specified time are
classified overdue.

Enter the number of days credit allowed by your supplier in their terms.

Remembering to pay on time

Either the Automatic Payment facility or the reports,
Aged Creditors and Suggested Open Item Payments

can remind you which invoices are due for payment before the
supplier decides to do it for you…
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If applicable, enter the discount percentage that
this supplier allows you for early payment…

In addition to normal credit
facilities, some suppliers offer
an Early Settlement Discount.
This is a special arrangement
where the supplier allows you to
deduct a specified percentage
from the invoiced amount in
exchange for early payment.

If an Early Settlement Discount
is offered, enter the discount
percentage allowed for early
payment and the number of days
allowed for qualification.
Having entered these details,
Bottom Line calculates the
discount allowed for each invoice
raised against this supplier as
described in the next chapter.

More about Early Settlement Discounts

You should ensure that you have set up a General Ledger account to benefit from
any Early Settlement Discounts — and that you have entered the number of that

account in the Purchase Accounts Details window (as described in the previous chapter).

…then enter the
number of days
which allow you
to qualify for that
discount.
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Balances
Unless you are starting a new
business, you will need to
transfer all uncleared invoices,
credit notes and payments for
each existing supplier.  However!
Before you enter the outstanding
supplier balances, you are
advised to read the notes on these
entries over the page…

Balance Due for Payment:
EITHER, leave this entry
blank so that the un-cleared
invoices and credit notes can
be posted to this account...

…OR, type the total amount
that has yet to be paid to this
supplier.

Unallocated Payments:
EITHER, leave this entry blank
so that any prepayments can
be posted to this account...      …OR, type the total amount paid to this supplier that has not yet been allocated.
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Cutting Corners

Entering a single balance
amount is quicker than

posting the outstanding transactions
one at a time.  HOWEVER! If you do
this you will need to keep referring
back to your previous books to check
which payment matches which trans-
action until, eventually, all the items
are cleared.  In other words, entering a
single balance amount may be easier
at the outset but could cause more
work in the long run.

Entering Cash Values

The cash values — Balance
Due, Unallocated Payments

and Turnover — need only be entered
if there are ‘open items’ — such as
unpaid invoices, unallocated credit
notes or prepayments to this supplier.

Balances (continued)

To ensure continuity with your previous books. you may need to carry
forward the amount outstanding for this supplier account.  You can do
this in one of two ways...

The first, and strictly correct, way is to leave the Balance Due for
Payment entry blank and to post all un-cleared invoices and credit
notes to this account — as described in the next chapter.  When you
do this Bottom Line updates the Balance field in the Supplier account
with the relevant amount(s) — and, on posting to the General Ledger,
adjusts the relevant Asset or Expense account balances.

The second option is to type a single balance amount in the Supplier
record — which, in turn, will update the Purchase Ledger but not the
General Ledger.  The facility to directly enter the Balance amount is
only available during the initial setting up period — once this period
is closed, the supplier balance can only be updated by posting the
relevant transactions.

The Unallocated Payments entry records the total money paid on
account to this supplier that has yet to be allocated to specific invoices
and/or credit notes.  If you are transferring an existing supplier
account then you are faced with the same choice as above…
…Do you take the (initially) easy option of entering the unallocated
payments as a lump amount or do you post them individually?
Having made your decision, either type the amount — or, leave this
entry blank in preparation for posting each unallocated payment.



Chapter 11 - 13

Building the Supplier Database

Turnover
If switching to Bottom Line part
way through your financial year,
you can use the Turnover This
Year entry to transfer the net
value of business transacted with
this supplier for the current year.

Similarly, use the Turnover Last
Year entry to transfer the value
of business conducted with this
supplier for the previous year.

More about turnover

There is no need to enter the turnover amounts straight away.  In fact, it is advisable to postpone
entry of the current turnover until you have posted any outstanding transactions to this account.  You

can then return to this window and top up the net turnover figure so that it correlates with your existing books

Once you have set up the turnover, Bottom Line maintains these figures for you.

If applicable, enter the total
value of transactions with this
supplier for the year to date…

…and for the previous year.
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Auto Purchases

Click here to select the automatic purchase facility.

Enter the last period in which
an invoice was generated.

Enter the invoice amount, excluding VAT…      …enter the VAT amount.

Enter the analysis code to map the purchase
to the correct General Ledger account.

Enter the code for the
VAT rate to be applied.

For some suppliers, you may
need to raise invoices each
accounting period which always
contain the same purchase
information — for example,
when paying the rent for your
business premises.

To avoid repeating the same
invoice details every accounting
period, Bottom Line provides an
Auto Purchase template which
allows you to set up the standard
purchase information like this…

Generating an Automatic Invoice

Once the purchase template has been set up, you can produce an Automatic Invoice for the current
period by first selecting the relevant supplier account then choosing Generate Automatic Invoice from
the Purchase menu.  Turn to the next chapter for more information.
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Saving the Supplier Account Having entered the relevant information, save the
supplier account as shown here.
Once saved, the
new supplier
account appears
in the appropriate
category window.

Click here to close the window.  If any
un-saved details are detected, you will be
asked to save or ignore any  changes.

Click here to erase the new account.

Click here to add the supplier account to the
database.  You will now see this dialogue…

Type a short unique reference
name for this account.

Click the
supplier
category in
which you
want to save
the account.

Click OK to add the new account.
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Modifying a Supplier Account
If, at any time, you want to check or modify the details for a particular supplier then open the relevant category
and account like this…

From the Purchase Ledger window, double click the supplier category containing the
account you want to change.

EITHER, by icon…                  OR, by name…

Double click the relevant account icon or name to open it.

Double click the Supplier Details icon
to access and modify the existing
details for this supplier then…

      …make changes in the usual way.

If you intend to edit the Balance
amounts then turn the page…
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Editing Cash Values

In order to correct any initial errors quickly and with the minimum of fuss, the Alter Supplier
Details window includes the facility to edit cash values, as well as text entries.  This facility also

offers flexibility over the entry of turnover values which you may want to enter immediately or postpone to
another, more convenient, time.

However! You should take care when modifying the entries for Balance Due and Unallocated Payments.
You may only edit these values during the initial
setting up period — and each time you do this,
Bottom Line reminds you that any changes will
not be reflected in the General Ledger. ..

Once you have closed the start-up period the
integrity of each account balance is then
maintained by posting the relevant transactions
— as described in the next chapter.

Viewing supplier accounts

The accounts assigned to each supplier category can be viewed in one of two ways — as icons or as a
list of account names.

To switch from one mode to another, choose the relevant option – By Icon or By Name – from the View menu.
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Re-organising Supplier Accounts
As the supplier database expands, you may find that
you want to reorganise your supplier accounts — for
example, to relieve any categories which are bulging at
the seams.

Use Change Item from the Edit menu to transfer an
existing supplier account from one category to another
as shown on the next page…

Re-naming a supplier account

You can also use the Change Item command
to revise the supplier’s short reference name

without necessarily moving it into a different cat-
egory — simply type the new reference name for the
account in the Change Supplier dialogue box but
leave the existing supplier category unchanged.

First find your supplier

You can locate a supplier account by first
locating the supplier category, opening it

then locating the supplier’s name.

Alternatively you can choose Find from the Edit
menu to locate a supplier by name (or part of the
name). Find is explained in Chapter 19.
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Transferring a supplier account to a different category

Open the relevant supplier category then
select the account that you want to move by
clicking its icon (or if viewing By Name, by
clicking the account name).

Choose Change Item
from the Edit menu to
display this dialogue…

If necessary, change the
account’s reference name to
match the indexing system in
the destination category.

Click the new destination
category to select it.

Click OK to transfer the
account to the selected
category.
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Deleting a Supplier Account
Sooner or later you may want to delete all those
supplier accounts which are quietly gathering dust.
You can do this provided that...

• The account balance is zero.

• There are no transactions associated with this account.

Having satisfied these two conditions, delete the
unwanted supplier as described opposite…

Preserving history

Bottom Line allows you to delete a
supplier provided that you comply with

the above conditions.

However! The report ‘Supplier List’ illustrates
turnover for the current and previous years which
provide a total for all suppliers in the database.  To
preserve the integrity of these statistics, you may
therefore want to retain suppliers on file for a couple
of years until their turnover figures are also zero.

Open the relevant supplier
category then select the account
that you want to remove by
clicking its icon (or name).

Choose Delete Item  from the
Edit menu to display the
following dialogue box. . .

…then click the Delete button to
remove the unwanted supplier
account
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